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Preface

Information in this document is subject to change without notice.
© 2007 ERL Phase Power Technologies Ltd. All rights reserved.

Reproduction in any manner whatsoever without the written permission of
ERL Phase Power Technologies Ltd. is strictly forbidden.

This manual is part of acomplete set of product documentation that includes
detailed drawings and operation. Users should evaluate the information in the
context of the complete set of product documentation and their particular
applications. ERL Phase assumes no liability for any incidental, indirect, or
consequential damages arising from the use of this documentation.

While all information presented is believed to be reliable and in accordance
with accepted engineering practices, ERL Phase makes no warranties as to the
completeness of the information.

All trademarks used in association with B-PRO, F-PRO, L-PRO, ProLogic,
T-PRO, TESLA, TESLA Control Panel, RecordGraph and RecordBase are
trademarks of ERL Phase Power Technologies Ltd.

Windows® and Access® are registered trademarks of the Microsoft
Corporation.

Contact Information

ERL Phase Power Technologies Ltd.
Website: www.erlphase.com
Email: info@erlphase.com

Technical Support
Email: support@erlphase.com
Tel: 204-477-0591
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Version Descriptions

RecordBase Central Station Version Compatibility

This chart indicates compatibility between versions of RecordBase Central Station and
RecordBase View

Release RecordBase Central Station Compatible RecordBase
Date Version View Version

2007 Apr 13 vl4 v1.5

2005 Aug 31 | v1.3 v1.3

2003 Apr 17 v1l.2 v1l.5

2002 Oct 30 v1.1b vlil-vl4

2002 May 06 | vl.la vli1l-vl3

2001 May 04 | v1.1 vl.l

2001 Feb 13 | v1.0 v1.0

RecordBase Central Station Version Summary
RecordBase
Release Central Change Summary
Date Station (for details, see the Release Description)
Version
2007 Apr 13 vl4 Supports TESLA 3000 Cooperative Mode and improve-
ments to running under Windows limited user accounts
2005 Aug 31 | v1.3 Supports TESLA 3000 and 2000
2003 Apr 17 v1l.2 Adds LAN support to TESLA communication.
Supports systems with up to 100 TESLA recorders.
2002 Oct 30 v1l.1b Supports the latest version of record produced by the
TESLA recorder.
2002 May 06 | vl.la Increased maximum size of the IED phone number to 50
characters.
Corrected handling of records with >100 events.
2001 May 04 | v1.1 Uses RecordBase View as the Server’s record user inter-
face.
2001 Feb 13 | v1.0 First release.
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Version Descriptions

RecordBase Central Station User Manual Revision History

Date i\//l;r;?:rl] Changes from Previous Version

2008 Feb 29 | v1.4 Revl Branded to ERLPhase.

2007 Apr 13 v1l.4 Update to RecordBase v1.4

2005 Aug 31 | v1.3 Update to RecordBase v1.3

2003 Apr 17 v1.2 Update to RecordBase v1.2.

2002 Oct 30 v1l.1 Rev 4 Update to include new features and new format.
2002 May vl.1 Rev3 Add to version description tables.

2002 May 09 | v1.1 Rev 2 Incorporate Addendum 1 into manual.

2001 May 04 | v1.1 Manual reflects software changes.

2001 Feb 13 | v1.0 First release.
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Using This Guide

ThisUser Manual describestheinstallation and operation of RecordBase Cen-
tral Station software. It isintended to support the first time user and clarify the

details of the equipment.

RecordBase View, the record database and graphicstool, is described in a sep-

arate user manual.

The manual uses anumber of conventions to denote specia information:

Example

Describes

Start>Settings>Control Panel

Choose the Control Panel submenu in the Set-
tings submenu on the Start menu.

Right-click Click the right mouse button.
Recordings Menu items and tabs are shown in italics.
APT_RB_1 User input or keystrokes are shown in bold.

Text boxes similar to this one

Relate important notes and information.

Different coloured icons denote the different program sections.

RecordBase
System Manager (blue)

RecordBase Collector (green)

SHEHET

RecordBase Administrator (red)

Ty
i

RecordBase Monitor (yellow)
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RecordBase Central Station User Manual






1 System Overview

The RecordBase Central Station software provides automated collection, stor-
age and network-wide access to fault and disturbance data produced by TES-
LA Model 2000 and 3000 recorders. RecordBase ensuresyour recorder datais
automatically brought to asecure central |ocation and is made availableto staff
throughout your company for display and analysis.

TESLA Recorder

-l

TESLA Recorder

Telephone
Network Corporate RecordBase
LAN i

Modem View

—
d RecordBase

Modem Server

= —

—
-

TESLA Recorder

View

TESLA Recorder

= |

TESLA Recorder

Figure 1.1: System Overview

RecordBase Features

Provides automated record transfer from TESLA recorders on a call-out
schedule or by arecorder initiation

Allows central cross-triggering of TESLA recorders for system-wide dy-
namic swing recording

Includes integrated record database with search, sort and filter functions

Access company-wide records on existing Windows Computers through
the corporate LAN

Providesagraphical, interactive record display with timebase, phasor, har-
monic and impedance analysis tools

Provides record summaries with classification and shared commentary
work space

Provides graphical and numeric export to support generation and special
anaysis

Supports systems with up to 100 recorders

Supports both modem and LAN communication

Supports TESLA 3000 Cooperative Mode

D02261R01.41
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1 System Overview

System Description

Central Station
Software

RecordBase View

RecordBase
Database

RecordBase consists of two main components:

* RecordBase Central Station is a set of modules which handle record col-
lection and storage

» RecordBase View provides access to the data on existing desktop comput-
ersover the corporate LAN

The Central Station handles record acquisition and cross-triggering with
TESLA recorders and maintains the central database of records. RecordBase
Central Station communicates with TESLA recorders using modems and/or
LAN. RecordBase Central Station runs on a PC with , Windows 2000 or
Windows XP operating systems, and that PC should be dedicated to this
purpose only.

Y ou can configure RecordBase Central Station to call TESLA recorders
through amodem or LAN and automatically download new records. Y ou can
also set the call order and the call time.

RecordBase Central Station accepts incoming calls from arecorder through a
modem or LAN. Y ou can set the recorder to notify RecordBase Central Station
of adynamic swing trigger or anew high priority record produced by the re-
corder.

RecordBase Central Station maintains a database of information from the
records it collects. The database, as well as the downloaded record files, may
be located on the server’s hard disk or on another drive on the network. This
allowsyou to place your datain a more secure |ocation managed by your com-
pany’s information systems staff (if available).

RecordBase Central Station is configured and managed using RecordBase
Tools (Collector and Monitor) to control and to monitor its operation. These
tools can be run on the server itself or remotely on another computer on the net-
work.

RecordBase View isaseparate software client program (for details see Record-
Base View User Manual). It is the primary tool for those who work with the
data collected from the recorders. RecordBase View provides database search
and sort functions, a summary display of each record, report tools and interac-
tive display graphics.

RecordBase View can run on existing desktop PCs running Windows 2000 or
XP operating systems, and can access data on the RecordBase Central Station
computer over the existing corporate LAN. Y ou can aso run RecordBase
View on the same computer as RecordBase Central Station.

The RecordBase database is based on Microsoft Access. Dataisstoredinasin-
glecentral Accessdatabasefile maintained by RecordBase Central Station and
RecordBase Administrator. RecordBase View isimplemented using a run-
time version of Microsoft Access. It provides access to the RecordBase data-
base. Multiple access to the central database file is controlled through record
locking to ensure data integrity. Because RecordBase View uses arun-time
version of Access, you do not need to have Accessinstalled on either the Cen-

1-2
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1 System Overview

tral Station or any computer running RecordBase View. If you do have a copy
of Access, you can use it to create your own reports and displays.

What You Need To Set Up RecordBase

RecordBase Central For RecordBase Central Station
Station A Pentium PC running Windows 2000 or Windows XP

For Modem Communication

* One or two Windows-compatible modems (internal or external) with tele-
phone lines

- One modem for outgoing calls to recorders (required)
- Second modem for incoming calls from recorders (only required if
incoming calls viamodem are to be supported)

For LAN Communication
» LAN card with the operating system and hardware in use

 Storage space suitable for records and the database. (A typical TESLA
record isfrom 100 KB—1 MB.) Alternatively, the database and records can
be located on a network drive

» Network connection that supports the TCP/IP protocol—required only if
the database and records are stored on a network drive. LAN communica-
tion with TESLA isrequired.

 Data backup facility recommended, if you are storing TESLA records on
the server and there is no network-based backup facility

To display records on the Server, the computer should also meet the require-
ments for RecordBase View:

* Pentium class processor at 200 MHz or better is recommended

Display adapter that supports 800 x 600, small fonts mode is the minimum
64 MB or greater is recommended

Printer (optional)

RecordBase View * Pentium class processor at 200 MHz or better is recommended
o ontaane Windows 2000 or XP

» Network connection to the Server that supports the TCP/IP protocol
Display adapter that supports 800 x 600, small fonts mode is the minimum
64 MB or greater is recommended
Printer (optional), but a print driver isrequired to view the report summary

TESLA Recorders

TESLA 2000 Recorderswith Firmwarev2.1 or higher are required to work
with RecordBase using modem communication

» TESLA 2000 Recorderswith Firmware v3.6 or higher are required to work
with RecordBase using LAN communication

» RecordBase supports all versions of TESLA 3000

D02261R01.41 RecordBase Central Station User Manual 1-3



1 System Overview

RecordBase Modules

RecordBase Monitor

RecordBase
Collector

RecordBase
Administrator

Server Modules

RecordBase Central Station consists of a number of software modul es that
work together. In addition to the modules that provide the underlying commu-
nication and data acquisition functions, there are user interface modules used
to manage the system.

Server PC
Desktop PC
RecordBase
View RecordBase
View
Ethernet
RecordBase RecordBase RecordBase TCP/P RecordBase
Collector Administrator Monitor Monitor
[T
RecordBase
S " " Collector
erver Records an
Modules Database Files Tﬁ;f

| LAN ||Modem| |Modem|

Figure 1.2: RecordBase Modules

RecordBase Monitor displays the type and result of the last communication
session with each TESL A recorder. It provides access to the system’s commu-
nication activity and diagnostic logs. The Monitor also has controlsto initiate
an immediate cross-trigger of al recorders or to initiate a record collection
call-around. The Monitor isused by the system administrator or by general Re-
cordBase users who need basic status information and the ability to initiate ex-
ceptional record acquisition action. It can be run on the Server or an another
PC on the network.

RecordBase Collector provides control over the system’s record collection
function. It identifiesthe TESLA recorders and specifies the record collection
and cross-trigger rules. RecordBase Collector is a system administrator’ s tool
and istypically run on the Server, although it can be run from any network
computer.

RecordBase Administrator provides database management tools including
record deletion, modification and import. The Administrator is a system ad-
ministrator’ s tool and must be run on the Server.

The Server Modules are aset of software componentsthat control the automat-
ed record collection and communication functions. They run continuously on
the Server machine and form the core of the RecordBase system.

1-4
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1 System Overview

RecordBase Versus TESLA Control Panel

Running Control
Panel on the
RecordBase Central
Station

TESLA Control Panel software is the basic user interface for the TESLA re-
cordersto configure and control the recorder. RecordBase does not replacethis
function.

TESLA Control Panel version 2.1 or greater is required to configure
a TESLA to work with RecordBase via modem. This version contains
settings to control TESLA calls to RecordBase to report swing
triggers or to initiate record transfer.

TESLA Control Panel version 3.6 or greater is required to configure
TESLA to work with RecordBase via LAN.

As an alternative to the above, TESLA 3000 Control Panel v1.0 or
above can be used.

Control Panel may be run on the RecordBase Central Station computer and
make use of the Server’s outgoing modem or LAN card to communicate with
recorders.

If using amodem, the Server must have an APT_MODEM dial-up network
configuration for TESLA Control Panel to use (refer to TESLA User Manual
for further details). Set it up to use the same modem as RecordBase uses for
dial-out.

When Control Panel is using the modem, RecordBase is unable to useit. Re-
cordBasetreatsthisasafailed call attempt and followsits configured call retry
rules. If the maximum number of retriesis reached, RecordBase abandons the
call attempt.

If RecordBaseis using the call-out modem when you try to connect to arecord-

er using Control Panel, Control Panel reports acommunication error. Y ou can
try again when RecordBase has finished with the modem.

If your system is set up to receive modem calls from recorders, ex-
tended use of the outgoing Server modem by Control Panel could re-
sult in missed cross-triggers or record transfers. If your system is set
up to receive LAN calls from recorders, this is not an issue.

D02261R01.41
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1 System Overview

Adding Records Itispossibleto manually add arecord that has been transferred from arecorder

from Control Panel using Control Panel to RecordBase. In Control Panel, select the desired record
from the Records List and use the Save As button to place the file on a diskette
or ashared directory. Use RecordBase Administrator to add the record to the
database.

Y ou can also use RecordBase View to add records to the RecordBase Central
Station database. To add arecord run RecordBase View and select File>Open.
From the drop-down menu select the RecordBase database (C:\Program
Files\NxtPhase\Recor dBase\Database\Recor dBase.mdb) and OK. Select Add
and choose the record to be added. The Records Found number should be up-
dated showing that you have added a new record. For more information refer
to the RecordBase View User Manual.

1-6 RecordBase Central Station User Manual D02261R01.41



2 RecordBase Central Station and Tools

Installation

The section “Planning Y our Installation” is common to both Windows 2000
and Windows XP.

For Windows 2000 server setup details and installation instructions refer to
“RecordBase Central Station Setup Overview (for Windows 2000)” on page 2-
3 and “Detailed Server Installation (for Windows 2000)” on page 2-4.

For Windows X P server setup details and installation instructions refer to “ Re-
cordBase Central Station Setup Overview (for Windows XP)” on page 2-14
and “Detailed Server Installation (for Windows XP)” on page 2-15.

Planning Your Installation

Full Server

RecordBase Tools

This section describes RecordBase installation and the avail able choices. For
system requirements see “What Y ou Need To Set Up RecordBase” on page 1-
3.

During Server software installation there are two options—Full Server Instal-
lation and RecordBase Tools Only.

Full Server installation installs the core server/database files and RecordBase
Tools. You should install only one instance of Full Server on your entire net-
work. This computer must have TCP/IP capability.

RecordBase Tools consists of two modules—RecordBase Collector and Re-
cordBase Monitor. These modules may be installed on the server or any net-
work computer to allow the administration of RecordBase Central Station
remotely. The network computer must haveaTCP/IPlink with the Server. You
may run approximately 15 simultaneous instances of Collector and Monitor.

Thetable below summarizesthefunctionality of RecordBase Tools, for details
see “Record Collection” on page 4-1 and “ Communication Monitoring” on

page 5-1.

Module Functionality

RecordBase Monitor Monitors communication with recorders.
Manually initiates system-wide swing trigger.
Initiates manual collection of records from a recorder.

RecordBase Collector Defines recorders and communication parameters.
Sets record collection times and rules.

Provides a way to shut down RecordBase.

Sets the number of logdfile entries.

D02261R01.41
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2 RecordBase Central Station and Tools Installation

Selection of a Server
Computer

Modems and
Telephone Lines

Network Connection

TCP/IP

To use RecordBase' s automatic record collection capability, we recommend
that you either dedicate a computer to run RecordBase Central Station or en-
sure that other programs that run on the shared computer are known and pre-
dictable.

We do not recommend installing RecordBase Central Station on a
computer that runs numerous different software packages or one that
is used for general day-to-day tasks.

The Server can be set up to use one or two modems to communicate with the
recorders. Thefirst modem (outgoing) isused exclusively for outgoing callsto
the recorders to collect records or initiate a swing recording. The second mo-
dem (incoming) is optional and is used for incoming calls from the recorders
to report new records or initiate swing cross-triggering. The need for thein-
coming modem depends on which communication features you plan to use.

Modem Required Communication Feature

Outgoing Schedule polling calls to recorders to collect records.
Manually initiate calls to recorders to collect records.
Manually initiate swing triggering to all recorders.

Incoming Allows new record notification from recorders.
Allows cross-trigger notification from recorders.

A connection to your LAN isrequired if you plan to do any of the following:
* Store your database on a computer other than RecordBase Central Station
» Analyze records from a computer other than RecordBase Central Station

« Configure and monitor the record coll ection process from acomputer other
than RecordBase Central Station

» Use RecordBase Central Station to fetch records or to initiate swing trig-
gering over the LAN

* Allow new record notification or cross trigger notification for recorders
over the LAN

Y ou do not need anetwork connection if you plan to store the dataon the server
machine and you work with record data only on that machine.

RecordBase Central Station requires TCP/IPin order to communicate with re-
corders, for details see “ Remote Access Service (RAS) Setup” on page 2-5 for
Windows 2000 and “Remote Access Service (RAS) Setup” on page 2-16 for
Windows XP. RecordBase Tools require TCP/IP to communicate with Re-
cordBase Central Station.

RecordBase View does not require TCP/IP to access RecordBase Database;
but the client machine (the PC that runs RecordBase View) must bein the same
network domain as RecordBase Central Station.

2-2
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2 RecordBase Central Station and Tools Installation

Data Storage

Full Server installation creates a default folder for RecordBase Database in
“C:\Program Files\NxtPhase\RecordBase Server\Database.” The database
folder containsthefilerb.mdb and all record files. Record files can range from
about 100 KB to 1 MB each, so make sure your hard disk has sufficient storage
space. We recommend that you do aregular backup of the database folder.

RecordBase Central Station Setup Overview (for Windows

2000)

RecordBase with
One Modem
Overview

RecordBase with
Two Modems
Overview

RecordBase with
LAN Overview

This section provides an overview of the stepsinvolved in setting up Record-
Base Central Station. Detailed instructions appear in following sections.
Decide first whether you wish RecordBase to use one modem (for calling
TESLA recorders), two modems (onefor calling TESLA recordersand another
for accepting callsfrom TESLA recorders) or LAN. RecordBase can also use
a combination of modems and LAN.

In this case RecordBase calls TESL A recorders for record collection.
1 Install Server software from the CD-ROM.
2 Define |EDs, for details see “ Adding a Recorder to the List” on page 4-3.

3 If desired, alow remote computers to access the RecordBase Database by
creating a share on the database folder (C:\ProgramFiles\NxtPhase\Record-
Base\database).

4

5 Ensure Windows 2000 Service Pack 2 or later is applied.

In this case RecordBase is not only able to call TESLA recorders, but isalso

ableto receive calls from them. In addition to the above steps, perform the fol-

lowing:

1 Create anew user account on the server machine for the TESLA recorders,
for details see “New User Account Setup” on page 2-4.

2 InControl Panel, Administrative Tools, Services ensure that the Routing
and Remote Access serviceis set to run automatically and modems are con-
figured and functional, for details see “Remote Access Service (RAS) Set-
up” on page 2-5.

In addition to (or instead of) modems, RecordBase has the ability to call TES-
LA Recorders and receive calls from them over the LAN.

1 Follow the stepsaccording to “ RecordBase with One Modem Overview” on
page 2-3, starting with step 1.

D02261R01.41
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2 RecordBase Central Station and Tools Installation

Detailed Server Installation (for Windows 2000)

New User Account
Setup

New User Account setup is only necessary for installations with two modems

(IEDs are allowed to call in and out).

1 InControl Panel Administrative ToolsComputer Management, opentheLo-
cal Users and Groups branch and right-click Users.

2 Choose New User... from the pop-up menu.

E Computer Management

=1o/x|

J Action  Wiew H(— -)“l@

| Description

Tres I Name [ Full ame
@ Computer Management {Local) madmm
S} ﬁ System Tools Admimstrator
[J-@ Event Viewer QGUESL‘

-G System Information mSMSCI\Schcct& SMICHSvCACCEE

[+ g Perfarmance Lags and Alerts mSMSCI\ToknAc.‘. SMSCliTokniccte:

[+ % Shared Folders VUSR_ROBER.‘. WSA Server Account
Device Manager

(=45 Local Users and Groups

LG
[—]& Storage View »
[ oiskm
- w DiskD  Refresh

=) Logica  Export List...

W Remor
B 85 Services

Help

Bwilt-ir account For administerin
Built-in account for guest acce:
DO NOT MODIFY, Syskems Mz
DO NOT MODIFY, Syskems Mz
Account For the Visual Studio A

|Crsates anew Local User account

Figure 2.3: New User

3 Create anew user account with the name tesla2000, type password as

T3S5A3720 and confirm.

4 Uncheck User must change password at next logon.

ol

6 Check Password never expires.

hewuser 2|

Check User cannot change password.

User name: |tesla2000
Full name: |
Description: |
Paszword: |"‘“‘"
LConfirm password: |”""

I™ Wser must chanoe password at nest logon

I~ Account is dizabled

Create I Close

Figure 2.4: New Account Information

7 Click the Create button and close the New User dialog box.
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2 RecordBase Central Station and Tools Installation

Remote Access
Service (RAS) Setup

Remote Access Service (RAS) Setup isonly necessary for installations with
two modems (IEDsareallowed to call inand out). Skip thissectionif you don’t
need modem access to/from recorders.

1 Goto Control Panel/Administrative Tools/Services.

2 Check the status of Routing and Remote Access service. The start-up type
should be set to Automatic and its status should be Sarted.

5y Services 1 i (=[]
| adion diew || &= = | M[mE|E A2 = 0 = ‘
Tree | Name /. | Description | Status | Startup Type | Logon. =]

[, Gervices (Local) || EaRemoke Access Auto Conneetia... Createsa . Manual LocalSy:

%Remote Access Connection Man... Createsa...  Starked Manual Lacaly:

“sRemote Administrator Service Started  Automatic Localys

%Remote Procedure Call (RPC) Pravides th... Started Autamatic Lacalsy:

%Ramote Procedure Call (RPC)L...  Managest... Manual Lacalsy:

“sRemote Registry Service Allows rem...  Started  Automatic Lacalsys

Started Automatic
Disabled

emovable Storage

outing and Remote Access

un

s Service Started Automatic LocalSye
%Securlty #Accounts Manager Stores sec..,  Starked Automatic Lacalsy:
Server Provides R...  Started Automatic LocalSy:
%Smart Card Manages a... Manual Lacalsy:
Sy Smart Card Helper Provides s. . Manual Localsys
%SMS Client Service Started Autamatic Asmscli
%SMS Hardware Inventory Agent... Manual Localsys
%SMS Remote Control Agent Started Automatic LocalSys
s%St\\l Image Service Started Autamatic Lacaly:
System Event Motification Tracks syst.,. Started  Automatic Localys
%Task Scheduler Enables a... Started Autamatic Lacaly:
%TCPIIP NetBIOS Helper Service Enables su..,  Starked Automatic | Localsys ¥
Al *

\ [ [
Figure 2.5: RAS Setup

3 Ifitisnot, double-click it to bring up Properties, set the Start-up Typeto
Automatic and start the service.

Routing and Remote Access Properties (Loc il |

General I Log On I Recovery I Dependencies I

Service name: Remotedcoess

Display name: IHouting and Remote Access

Description: Ifoers routing services to businesses in local area and v

Fath to executable:
o INM TS petern32hevchost exe -k netevos

Startup type:

Service statuz:  Stopped

Start | Stop I Bauge Eesume

“t'ou can specify the start parameters that apply when vou start the service
from here.

Start parameters: I

aK I Cancel Apply

Figure 2.6: RAS Properties

4 Go to Control Panel/Network and Dial-up Connections.
5 Double-click Incoming Connections.
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2 RecordBase Central Station and Tools Installation

7 Network and Dial-up Connections

J File Edit Wiew Favorites Tools  Advanced  Help |ﬁ
J Back = = - | & search  [YFolders  CEHistary | 7

Jnddress IlE] Metwork and Dislup Connections j (;)GD
Ilﬁ: @1 :.!'E!'l
= L L gn

Make Mew Local Area 8PT_RE_1
Connection Connection

|]. objectis) selected

Figure 2.7: Network and Dial-up Connection

6 Choose the dial-in modem to allow incoming calls.

Incoming Connections Properties I

General I Users | Networking |

— Incaming connechions

Allows incoming connections on these devices.
Devices:

O &5 5. Robotics 56K Fax PCI
™ &> 1.5, Robotics BEE Fax PCI #2

Properties I

—irkual private netwiork,

[ Allow others to make private cornections to my computer
by turneling through the Inkernet or other network;

¥ Show icons on taskbar when connected

] i Cancel l

Figure 2.8: Incoming Connections Properties

7 Gotothe Userstab and allow the “tesla2000” user to connect
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2 RecordBase Central Station and Tools Installation

Incoming Connections Properties I

Genersl Users lNetwnrkingI

Ilzerz allowed to connect:

I €& Administrator
O] € Guest

E tesla[tesl a2000]

[ f= [Delete Properties

Maote that ather factors, such az a disabled uzer account, may
affect a uzer's ability bo connect.

[ Reguire all uzers to zecure their passwords and data.

W Always allow directly connected devices such as palmtop
computers to connect without providing & pazzword,

OF. I Cancel l

Figure 2.9: TESLA User Connection

8 Gotothe Networking tab, ensure Internet Protocol (TCP/IP) ischecked, se-
lect it and click Properties.
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Incoming Connections Properties

General I gers  Metmarking

MHetwork components:
Y Intemet Protocol [TCRAR)

'®| File and Frinter Sharing for Microsoft Metwaorks
=0 Cligrt for Micrasoft Metworks

Inztall... Lninztall I Froperties I

 Description 1

Tranzmizzion Control Protocal/lnternet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

OF. I Cancel

Figure 2.10: Networking Properties

9 Uncheck the Allow callersto access my local area network.

10 Check the Specify TCP/IP addresses and enter a From address of
192.168.102.160 and a To address of 192.168.102.180.

11 Uncheck the Allow calling computer to specify its own IP address.

Incoming TCP/IP Properties E I

— Metwork access |

[ &llows callers to access my losal area netwark:

— TCRAP address assignment
" Azsign TCPAP addresses automatically using DHCP

& Specify TCP/P addiesses

From: | 192 . 168 . 102 . 160
T | 192 . 168 . 102 . 180
Total: i21

[ allowe calling computer ta specify its own IP address

Ok i Cancel

Figure 2.11: TCP/IP Address

2-8
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12 Click OK to close the Incoming TCP/IP Properties dialog box.
13 Click OK to close the Incoming Connections Properties dialog box.

Skip this section if you don’'t need modem access to recorders.

Phone Book Entry 1 First manually copy thefile “c:/program files/accessories/RBtesla.scp” to
Setup the “ c:/winnt/system32/ras/” directory.

2 Goto Control Panel, Network and Dial-up Connections.

3 Double-click Make New Connection to open the Network Connection Wiz-
ard.

Network Connection Wizard

Welcome to the Network
Connection Wizard

Llging thiz wizard pou can create a connection to other
computers and networks, enabling applications such az
e-mail, Web browsing, file sharing. and printing.

To continue, click Nest.

Cancel

Figure 2.12: Create a Connection

4 Choose Network Connect Type as Dial-up to private network and click
Next.

Network Connection Wizard I
Metwork Connection Type
You can choose the type of network. connection you wank to create, bazed on
your hetwork configuration and waur nebwarking needs.

% Dial-up to private network
Connect uzing my phone line [modem or ISDM].

" Dial-up to the Internet
Connect to the Intermet uging my phone line [modem or [SDM].

CiC t to a priv twork through the Internet
Create aVirtual Private Metwaork [VPN] connection or tunnel’ through the Internet.

" Accept incoming connections
Let ather computers connect o mine by phone line, the Intemet, or direct cable.

" Connect directly to another computer
Connect using my zenial, parallel. or infrared port.

< Back l Mest » | Cancel

Figure 2.13: Network Connection
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5 Sedlect the modem to be used for dial-out. Click Next.

Network Connection Wizard
Select a Device
Thiz iz the device that will be used to make the connection.

“r'ou have more than one dial-up device on wour computer.

Select the devices to use in this connection:
D Madem - U.S. Robotics 56K Fax PCl #2 [COM4)

£t Modemn - 5. Ro : PCI [COM3)

< Back I Mext > I Cancel

Figure 2.14: Choose Modem

6 Leavethe Phone Number to Dial as blank. Click Next.

Network Connection Wizard I

Phone MNumber to Dial
“r'ou muzt specify the phone number of the computer or netwark you want to

connect to.

Type the phone number of the computer or network. you are connecting to. If pouw want

your computer to determine automatically how to dial from different locations, check Uze
dialing rulez.

| o=} Phane number:

| =

B gl i

l iz

™ Use disling niles

< Back I Mest I Cancel

Figure 2.15: Dialin Telephone Number
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7 Choose Connection Availability as For all users. Click Next.

Network Connection Wizard I

Connection Availability
“r'ou may make the new connection available to all users, or just poursell.

“t'ou may make this connection available ta all uzers, or keep it anly for your own use. A
connection stored in pour profile will not be available unlez: vou are lagged on.

Create this connection:

= Only for mysel

< Back I Mest » I Cancel

Figure 2.16: Connection Availability

8 Call this connection exactly as APT_RB_1 (must be exactly as shown).
Click Finish.

MNetwork Connection I

Completing the Network
@ Connection Wizard
Tupe the name you want ta use far this connection:

!AF‘T_HBJ

To create this connection and save it in the
Metwork. and Dial-up Connections folder, click
Finish.

To edit thiz connection in the Metwork and Dial-up
Connections folder, select it, click File, and then click
Propertias.

[ Add a shorteut ta my desktop

< Back I Firizh I Cancel

Figure 2.17: Connection Name
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9 Click Propertiesin the Connect APT_RB_1 dialog box that opens.

Connect APT_RB_1 K B3 |

Ilzer name; I

Fassword: I

[ Save paszwaord

Dial | [~

Dial I Cancel Froperties I Help |

Figure 2.18: Connect APT_RB_1

Gereral | Optins | Secuiy | Metwatking | Snaing |

Conrect using:

[T Use difing wles f |

B Sk ke b baskbar sden conpechsd

ok | caneel |

Figure 2.19: Choose Modem
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10 Select the Security tab and set it to run the script “ RBteda.scp”. Click OK.

|APT_RE_1 Properties

Figure 2.20: Security Properties

11 Cancel the Connect APT_RB_1 dialog box that appears.
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RecordBase Central Station Setup Overview (for Windows

XP)

RecordBase with
One Modem
Overview

RecordBase with
Two Modems
Overview

RecordBase with
LAN Overview

This section provides an overview of the stepsinvolved in setting up Record-
Base Central Station. Detailed instructions appear in following sections.
Decide first whether you wish RecordBase to use one modem (for calling
TESLA recorders) or two modems (one for calling TESLA recorders and

another for accepting calls from TESLA recorders). The latter case involves
more installation steps.

In this case RecordBase calls TESLA recorders for record collection.

1 Ingtall Server software from the CD-ROM.

2 Define IEDs, for details see “ Adding a Recorder to the List” on page 4-3.

3 If desired, allow remote computers to access the RecordBase Database by
creating ashare on the database folder (C:\ProgramFiles\NxtPhase\Record-
Base\database).

4 Ensure Windows XP Service Pack 1 or later is applied.

Inthis case RecordBaseis not only ableto call TESLA recorders, but also able

to receive calls from them. In addition to the above steps, perform the follow-

ing:

1 Create anew user account on the server machine for the TESLA recorders,
for details see for details see Figure 2.22: New Account Information on
page 2-15.

2 InControl Panel, Administrative Tools, Services ensure that the Routing
and Remote Access serviceis set to run automatically and modems are con-
figured and functional, for details see “Remote Access Service (RAS) Set-
up” on page 2-16.

3 Continue asin the section “RecordBase with One Modem Overview” start-
ing with Step 2.

In addition to (or instead of) modems, RecordBase has the ability to call TES-
LA Recorders and receive calls from them over the LAN.

1 Follow the steps according to “RecordBase with One Modem Overview”
on page 2-14 starting with step 1.

2-14

RecordBase Central Station User Manual D02261R01.41



2 RecordBase Central Station and Tools Installation

Detailed Server Installation (for Windows XP)

New User Account
Setup

New User Account setup is only necessary for installations with two modems

(IEDs are allowed to call in and out).

1 InControl Panel Administrative Tools/Computer Management, open the Lo-
cal Users and Groups branch and right-click Users.

2 Choose New User... from the pop-up menu.

E Computer Management |

=1o/x|

J Action  Wiew H(— -)“l@

Tres I Mame | Full ame | Description
@ Computer Management {Local} madmm
=1 ﬁ System Taols Admimstrator Ewilk-in account For administeri
-] Event Viewsr B cuest Built-in account for guest acce:

-G System Information mSMSCI\Schcct& SMICHSvCACCEE

[+ g Perfarmance Lags and Alerts mSMSCI\ToknAc.‘. SMSCliTokniccte:

[+ % Shared Folders VUSR_ROBER.‘. WSA Server Account
Device Manager

(=45 Local Users and Groups

LG
[—]& Storage View »
[ oiskm
- w DiskD  Refresh

=) Logica  Export List...

W Remor
B 85 Services

Help

DO NOT MODIFY, Syskems Mz
DO NOT MODIFY, Syskems Mz
Account For the Visual Studio A

|Crsates anew Local User account

Figure 2.21: New User

3 Create anew user account with the name tesla2000, type password as

T3S5A3720 and confirm.

4 Uncheck User must change password at next logon.

5 Check User cannot change password.
6 Check Password never expires.

Uszer name: IleslaZDUD
Full name: I
Descriptior: I
Password: I"‘“‘"
Lonfirm pazsward: I’““‘"

I User must change password &t rest logar
vl h
i
[ Account is disabled

pazsword

=

Figure 2.22: New Account Information

7 Click the Create button and close the New User dialog box.
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Remote Access
Service (RAS) Setup

need modem access to/from recorders.
1 Goto Control Panel/Administrative Tools/Services.
2 Check the status of Routing and Remote Access service. The start-up type

should be set to Automatic and its status should be Sarted.

# =lol =
| acion yew |]1--v\-||@|_\>l|| " ‘
Tree | fame  / | Description | Status | Startup Type | Lag On.:l

@ Services (Local) %Ramote Access futo Cannectia,,, Createsa .., Manual Localsy:

%Ramﬂta Access Connection Man... Createsa ... Started Manual LocalSy:

%Remote Adrinistrator Service Started Autamatic Lacalsy:

s Remote Pracedure Call (RPC) Provides th.,. Started  Automatic Localys

%Remote Procedure Call (RPC)L... Managest... Manual LacalSy:

%Rsmuts Registry Service Allows rem,.,  Starked Automatic Localsys

Managesr... Started Automatic LocalSy:

%Ramﬂvahla Storage

ting and R
uns Service

Enables st...

Started utomatic
%Security Accounts Manager Stores sec...  Starked Automatic
Server Provides R...  Started Automatic
%Smart Card Manages a... Manual
%Smart Card Helper Pravides 5., Manual
%SMS Client Service Started Automatic
%SMS Hardware Inventory Agent... Manual
%SMS Remote Control Agent Started Automatic
%stﬂl Image Service Started Autamatic
System Event Motification Tracks syst.,, Started Autamatic
Sy Task Scheduler Enablesa.. Started  Automatic
Enables su... Started Automatic

%TCPIIP MetBIOS Helper Service
4

Localys
Lacaly:
Localsys
LocalSy:
Lacalsy:
SMSCl
Lacaly:
Localsys
Lacalsy:
Lacalsy:
Localys

Lacalsy: ¥
| r

Figure 2.23: RAS Setup

Remote Access Service (RAS) Setup isonly necessary for installations with
two modems (IEDsareallowed to call inand out). Skip thissectionif you don’t

3 Ifitisnot, double-click it to bring up Properties, set the Start-up Typeto

Automatic

Routing and Remote Access Properties (Loca

General I Log On |
Service name:
Dizplay name:
Dezcriphion:

Fath to executable:

and start the service.

Recoveny I Dependencies I

Remotedcoess

IHouting and Remote Access

Ifoers routing services to buzinesses in local area and v

C:Aw MM T S pstern32hevchost exe -k netevcs

Startup type:

Service shatus

Start: |

Stopped

Stop | Bause Eesume

“r'ou can specify the start parameters that apply when you start the service

from here.

Start parameters:

kK I Cancel Apply

Figure 2.24: RAS Properties

2-16 Record

Base Central Station User Manual

D02261R01.41



2 RecordBase Central Station and Tools Installation

4 Go to Control Panel/Network Connections.
5 Double-click Incoming Connections.

] Network and Dial-up Connections E=
JFiIe Edit  Wiew Favorites Tools  Advanced  Help |

J Bagk = o= w | @Search G Folders  £ZHistary | 2

J‘ﬁ.ddress |@ Metwork and Dial-up Connections j -f?Go
3 = o
= Lot L&

Make Mew Local Area APT_RE_1
Connection Zonnection

|]. ohject(s) selected 7

Figure 2.25: Network Connections

6 Choose the dial-in modem to allow incoming calls.

e, N . -
&= |Incoming Connections Properties

General |Users Networking

Incoming connections

Allow incoming connections on these devices.

Devices:
&> HCF 56K Modem

O % Infrared Port (IRDAD-0)
O % Direct Parallel (LPT1)

Virtual private netwaork

[[] Allow others ta make private connections to my computer
by tunneling through the Intemet or other netwark

Show icon in notification area when connected

oK | [ Cancel

Figure 2.26: Incoming Connections Properties

D02261R01.41
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7 Gotothe Userstab and allow the “tesla?000” user to connect

2= Incoming Connections Properties

General | Users NB'[\'\l'Ul'kiﬂEl|

Network compenents:

Y Intemet Pratocol (TCP/IP)

M| File and Printer Sharing for Microsoft Networks
=, Client for Microsoft Networks

Description

Transmission Cortrol Protocal/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

[ ok |[ Canesl

Figure 2.27: TESLA User Connection

8 Gotothe Networking tab, ensure Internet Protocol (TCP/IP) ischecked, se-
lect it and click Properties.

[ . . .
&= Incoming Connections Properties

General | Users Networking|

Metwork components:

Y Inmtemet Protocol (TCP/IF)
File and Printer Sharing for Microsoft Networks
=) Client for Microsoft Networks

Description

Transmission Control Protocol/Intemet Protocal. The default
wide area network protocol that provides communication
across diverse interconnected networks.

[ ok ][ Cancel

Figure 2.28: Networking Properties

9 Uncheck the Allow callers to access my local area network.
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Phone Book Entry
Setup

10 Check the Specify TCP/IP addresses and enter a From address of
192.168.102.160 and a To address of 192.168.102.180.

11 Uncheck the Allow calling computer to specify its own IP address.

Incoming TCP/IP Properties

Network access

[] Allow callers to access my local area network

TCP/IP address assignment
() Assign TCP/IP addresses automatically using DHCP

(+) Specify TCP/IP addresses

From: [ 192 . 168 _ 102 . 160
To: | 132 . 168 . 102 . 180
Total: 21

[] Mllow calling computer to specify its own IP address

[ oK ] [ Cancel

Figure 2.29: TCP/IP Address

12 Click OK to close the Incoming TCP/IP Properties dialog box.
13 Click OK to close the Incoming Connections Properties dialog box.

Skip this section if you don’t need modem access to recorders.

1 First manually copy the file “c:/program files/accessoriessRBtesla.scp” to

the “ c:/winnt/system32/ras/” directory.

2 Go to Control Panel, Network Connections.

3 Double-click New Connection Wizard to open the New Connection Wizard.

New Connection Wizard

Welcome to the New Connection
Wizard
This wizard helps you:

* Connect to the Intemet.

network.

* Set up a home or small office networ.

To continue, click Next.

* Connect to a private network, such as your workplace

Figure 2.30: Create a Connection
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4 Choose Network Connect Type as Connect to the network at my wor kplace
and click Next.

New Connection Wizard
Network Connection Type
What do you want to do?

() Connect to the Intermet
Connect to the Intemet so you can browse the Web and read email.

(%) Connect to the network at my workplace;

Connect to a business network (using dial-up or VPM) so you can work from home,
afield office, or ancther location.

() Set up a home or small office network
Connect to an existing home or small office network or set up a new one.
() Set up an advanced connection

Connect directly to another computer using your serial, parallel, or infrared port, or
set up this computer so that other computers can connect to it.

[ < Back “ Meat > ][ Cancel

Figure 2.31: Network Connection Type

5 Choose Dial-up Connection and click Next.

New Connection Wizard
Network Connection
Howv do you want to connect to the network at your workplace?

Create the following connection:

Connect using @ modem and a regular phone line or an Integrated Services Digital
Network (I5DM) phone line.
() Mirtual Private Network connection

Connect to the network using a virtual private network (VP N) connection over the
Intemet.

[ < Back ” Mext > ][ Cancel

Figure 2.32: Network Connection

6 Typeinthe name APT_RB_1 exactly as shown. Click Next.
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New Connection Wizard

Connection Name
Specify a name for this connection to your workplace.

Type a name for this connection in the following box.

Company Name

iAPT_HB_ﬂ

For example, you could type the name of your workplace or the name of a server you
will connect to.

[ <Back || Med> | [ Cancel

Figure 2.33: Connection Name
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7 Leave the Phone Number to Dial as blank. Click Next.

New Connection Wizard

Phone Number to Dial
‘What is the phone number you will use to make this connection?

Type the phone number below.

Phone number:

You might need to include a "1" orthe area code, or both. I you are not sure
you need the extra numbers, dial the phone number on your telephone. If you
hear @ modem sound, the number dialed is comect.

[ < Back “ Meat > ][ Cancel

Figure 2.34: Dialin Telephone Number to Dial

8 Click Finish.

New Connection Wizard

Completing the New Connection

@ Wizard
You have successfully completed the steps needad to

create the following connection:

APT_RB_1
* Share with all users of this computer

The connection will be saved in the Network
Connections folder.

[JiAdd a shortcut ta this connection to my desktop:

To create the connection and close this wizard, click Finish.

[ < Back “ Finish l[ Cancel

Figure 2.35: Completing the New Connection Wizard
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9 Click Propertiesin the Connect APT_RB_1 dialog box that opens.

Connect APT_RBE_1

Lser name: | |

Password: | |

[] Save this user name and password for the following users:

Diial: | V|

L_Qial ][ Cancel ][ Properties ][ Help

]

Figure 2.36: Connect APT_RB_1

= APT_RB_1 Properties

General |Options || Security || Netwarking || MVEIFICEdl

Connect using:

@ Madem - HCF 56K Modem (COM4)

Phone number

Area code: Phone number:

| [ Altemates

Country/region code;

[] Use digling rules

=]
[+1)

8

|1
i

Show icon in notification area when connected

[ ok J[ Cancel

Figure 2.37: Choose Modem
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10 Select the Optionstab and ensure the Settings match for detail s see Figure
2.38: Options Properties on page 2-24.

B~ APT_RB_1 Properties

Geneml| Options |Securi’r)r Networking | Advanced

Dialing options
Display progress while connecting
[ Prompt for name and password, certfficate, stc.

O Include Windows logon domain

Of

Redialing options

Redial attempts: 3 —

v

Time between redial sttempts:
|dle time before hanging up:

[] Redial f line is dropped

[ ok ][ cancel

Figure 2.38: Options Properties

11 Select the Security tab and set it to run the script “ RBtesla.scp”. Click OK.

B~ APT_RB_1 Properties

General Optionsl Security |Ne‘tworking Advanced

Security options
(®) Typical (recommended settings)
Validate my identity as follows:

|Allow unsecured password w

(O Advanced (custom settings)

Interactive logon and scripting
[[] Show terminal window

Bun script: COMWINNTASystem 32ras R Btesla.scp IRV

[ Edit... ][ Browse... ]

[ ok ][ Cancel |

Figure 2.39: Security Properties

12 Cancel the Connect APT_RB_1 dialog box that appears.
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Commissioning and Verification of RecordBase

Testing the Dial-Out
and/or Outgoing
LAN Connection

Communication must be tested to verify that RecordBase is configured
properly. Before RecordBase can communicate with aremote TESLA
recording system, therecorders must have Firmwareversion 2.1 or greater (for
modem communication) or version 3.6 or greater (for LAN communication)
and RecordBase Central Station must be running during the verification
process. To run RecordBase Central Station, select Sart>Program
Files>NxtPhase> RecordBase> RecordBase System Manager. Since the
Server modules run invisibly in the background, the blue RecordBase icon at
the bottom right corner indicates a running RecordBase Central Station.

This procedure verifies that RecordBase is able to dial out and communicate
with remote TESLA recorders. It applies whether your RecordBase system
communicates with TESLA recorders using modems or LAN.

Requirements
e TESLA recorder
* RecordBase Collector
» RecordBase Monitor

Procedure Overview
» Definea TESLA recorder to RecordBase.

« |nitiateacall from RecordBaseto the TESL A recorder. If the call succeeds,
RecordBase automatically fetchesits UnitID and Serial Number.

Procedure Details

1 Run RecordBase Collector and create aNew |ED by selecting the New but-
ton and input its L ocation and Phone Number or |P address. Select OK to
exit the New dialog box.

Setup New IED x|

UnitD:  foknown
ED Sedal#: [
IED Type: ]ﬁ
Location: W

— Communication-
" Modem

Phone Nurnber:

 LAN

IP Address: ] i I

% Do Mot Connect

Cancel

Figure 2.40: Set Up New IED

D02261R01.41
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Testing the Dial-In
and/or Incoming
LAN Connection

2 Select the newly created |ED from the list and the Edit button. Ensure the
phone number or | P addressis correct and select the Get Information From
IED button. RecordBase should start calling the IED within ten seconds.

EETEE x
Lt 1D ]Dorse_l,l #1
IED Serial #: |
IED Type: ] Tesla _]
Location: ]Dorse_l,l Station
1~ Communication -
+ Modem

Phaone Mumber: {1234

LN
|P &ddress: ] i]

" Do Mot Connect

Get Infarmation From [ED

Cancel

Figure 2.41: Edit IED

3 During the call, use RecordBase Monitor to view the status. When the call
ends, if all goeswell, the Call Status column should say successful and the
unit’ sUnitl D field should have been automatically filled in. Therewill also
be an entry for this operation in Monitor’s Activity Log view.

This procedure verifies that TESLA recorders can successfully dial into Re-

cordBase and communicate with it. Thisstep isonly applicable if RecordBase
has been set up with two modemsor if it communi cateswith TESLA recorders
over LAN. If your RecordBase system only has one modem, skip this section.

Requirements
e TESLA recorder
e TESLA Control Panel
» RecordBase Monitor

Procedure Overview
» Configure the TESLA recorder to notify RecordBase of new records.
* Trigger the recorder and allow it to call RecordBase.
» Use RecordBase Monitor to view the call status and activity.

Procedure Details

1 Verify the Dia-Out Connection by checking the preceding instructions. Re-
cordBase only accepts calls from |IEDs that are known to it (known IEDs
appear in RecordBase Monitor’ s 1ED list), so you must first establish a
working connection with an 1ED.
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Testing Database
Operation

Configure the TESLA recorder (using TESLA Control Panel) to notify Re-
cordBase when it has new records.

Trigger the TESLA to generate arecord (using Control Panel). This should
forceit to call RecordBase.

Monitor the activity using RecordBase Monitor (on the main |ED Status
screen). After the call is complete, the Call Type for that IED should be in-
coming, and the Call Status should be new records. An entry also appears
in the RecordBase Monitor’ s Activity Log view.

This procedure helpsto verify that TESLA recorders can successfully contact
RecordBase and communicate with it. This step is only applicable if Record-
Base has been set up with two modems. If your RecordBase system only has
one modem, skip this section.

Requirements

e TESLA recorder

» TESLA Control Panel

» RecordBase Monitor

» RecordBase Administrator (part of RecordBase Central Station installa-

tion)

Procedure Overview

* This procedure extends the Dial-Out test to actually fetch records and en-

sure they are entered into the RecordBase Database.

Procedure Details

1
2

Verify the Dial-Out Connection by using the preceding instructions.

Configurethe TESLA recorder (using TESLA Control Panel) not to notify
RecordBase.

Create one or more records on the TESLA recorder (using TESLA Control
Panel).

In RecordBase Monitor, select the |ED from the list and select the Collect
Now button. This queues acall to that IED for record collection.

Use RecordBase Monitor’ sActivity Log and Diagnostic L og viewsto watch
the process. When the call begins, the Diagnostic L og view showsthe name
of each record asit istransferred.

Wait until at least one record is transferred and then run RecordBase Ad-
ministrator. Verify that an entry for the transferred record appearsin its
record list.
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3 RecordBase Central Station Detalls

RecordBase Central Station software consists of a set of cooperative software
modul es to handle communication, record collection and the central database.

This chapter describesthe software modul es and how to start, stop and monitor

the RecordBase Central Station.

RecordBase Central Station Modules

The RecordBase Central Station modules run together on the designated Serv-
er computer providing the core RecordBase functionality.

Server Module

Function

RecordBase System Manager

Main Server module. Handles start-up and shutdown,

monitors the other modules, handles inter-module
communication.

RecordBase Collection Manager

Record collection and cross-triggering.

RecordBase Session Manager

Communication with recorder via modem.

RecordBase LAN Session Manager

Communication with recorder via LAN.

RecordBase Logfile Manager

Activity and diagnostic logs.

RecordBase Database Manager

Interface to database.

The Server modules run invisibly as background processes on your computer;
they do not have a user interface window.

Y ou interact with them using the RecordBase Monitor and RecordBase Col-

lector modules on the server or on another computer that has a TCP/IP link

with the server.
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3 RecordBase Central Station Details

Starting, Monitoring and Stopping the Server Software

Starting RecordBase  The RecordBase System Manager module handles system start-up and shut-
Modules down, automatically starting or stopping other server modules as required.

To start the server software, run RecordBase System Manager by launching it
through the Start menu (Start>Program Files>NxtPhase>Recor dBase Serv-
er>RecordBase SystemManager).

Y ou can configure your computer to automatically start RecordBase System

Manager by placing a short-cut to RecordBase System Manager in the Start
Menu.

At present, RecordBase System Manager does not support running
as a Windows service.

Checking The RecordBase Central Station modules are monitored continuously by the
RecordBase RecordBase System Manager. It ensures that the other modules are running
and restarts them if required.

When you run either RecordBase Monitor or RecordBase Collector, the status
of their link with RecordBase System Manager is shown at the bottom of their
window. If the status says*“ Connected,” then you know that all the Server mod-
ules are up and running.

;ﬁsmnl [t Lview Pro 1 B/32 1 'ﬁ RecordB ase Admin 1 Eﬁ Recordt ase Eol\ecturi E::HecurdBase Maritor I _}4 Exploring - C:4 \1 Eﬁ 822

Figure 3.1: RecordBase Tray Icon

On the Server machine, if RecordBase Central Station isrunning, thereisa
small RecordBase icon at the lower right corner of the screen.

Alternatively, you can use the Windows Task Manager to determine if the Re-
cordBase modules are running. Use the Ctrl, Alt and Del keysto bring up this
box. Select the Task Manager button and go to the Processestab. SystemMan-
ager.exe should be one of the processes running.
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3 RecordBase Central Station Details

Stoppin
Rec%ed Bgase

E windows NT Task Manager M= E3

£ windows NT Task Manager File  Dptions Wiew Help

File  Options  Wiew ‘windows Help
Lipplications  Processes 1 Performance]
Applications !F‘rucesses] Performance |

Image Mame J FID J CRU J CPU T\meJ Mem Usage i_A_i
S [ 1300 00000 1656 K
= Rurining SessionManager 45 00 0:00:00 2304 K
" RecordB ase Admin - [Recordd ase Admin] Fiurining nddeagrit exe B3 00 0000 40K
" FenoidB ase Collectar Running spoolss. exe £ 00 0:00:00 TEE
e peris (| B iee © m oe  zwex
Eiabrting iy tapistv.ea g 00 00n00 K,
pstares.exe 97 00 00000 92K
135Man.exe 100 oo 00000 e K
Logfileb anager 102 0o 0:00:00 1716 K

13531V, 818 122 0 o000 44K
130 00 0:00:44 3952 K
144 00 0:00:00 1980 K

zehanager

145 00 0:00:00 2076 K
Collector.exe 147 00 0:00:00 556 K.
Collectiontanag 151 an 0:00:00 1936 K.
nitvdm. exe 155 00 Ce00:00 176K
WIDIERET, BHE 0o 0:00:00
Msaccess exe 168 00 00040 4228 K L]
B Kot End Process

[Processes 26 [CPU Usage; 0% [Mem Usage: 43352,/ 1 e s e ——
\Processes: 26 CPU Usage: 0% Mem Uzage: 4294

Figure 3.2: Task Manager

Check if Remote Access Server isrunning, using NT’s Remote Access Admin
(Start>Programs>Administrative Tools> Remote Access Admin).

To shutdown RecordBase Central Station, use RecordBase Collector’ s Shut-
down button under it's Server Info tab.

RecordBase Central Station Database

RecordBase System Manager modul e starts, stops and adds new records to the
database automatically.

The central database is maintained in a Microsoft Access datafile called
RB.mdb in the default directory C:\Program Files\NxtPhase\RecordBase Serv-
er\database. The records uploaded from the recorders are stored here.

The RecordBase Central Station database is a shared database allowing access
by multiple users on the network through RecordBase View. Database access
by multiple usersis fully supported.
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4 Record Collection

RecordBase automatically retrievesrecordsfrom TESLA recordersthroughits
modem or LAN and adds them to its database. Record retrieval can be config-
ured to occur on a scheduled polled basis initiated by RecordBase or on are-
port-by-exception basis initiated by a recorder.

When RecordBase is collecting from a TESLA 3000 recorder that is part of a
Cooperative group, RecordBase will attempt to fetch record fragments from
each member of the Cooperative group and automatically combinetheminto a
single record.

It is assumed that before using RecordBase Central Station with Cooperative
group units, the user is familiar with, and has verified proper operation of, the
Cooperative group using TESLA Control Panel.

RecordBase Collector Module

RecordBase Collector isa utility program used to configure RecordBase’s
record retrieval and cross-triggering services.

¥ RecordBase Collector | _ (O] x|

IED Infa 1 Serverlnfo] Loglnfo]

Unit D Location
Demo #1
Bozwel H4
Darsey #1
Dorsey #2

[

| | Cloze |

Connected

Figure 4.1: Collector Module

RecordBase Collector can be run onthe Server or on any computer onthe LAN
that has a TCP/IP link with the server.
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4 Record Collection

Running
RecordBase
Collector the First
Time

If RecordBase Collector is running on the same computer as RecordBase Cen-
tral Station, then skip this section.

Thefirst time you run the RecordBase Collector you need to set the Server ID
under the Server Info tab to the name of the computer running RecordBase
Central Station. Alternatively you can type in the IP address of the computer
running RecordBase System Manager if you know it.

To determine the name of the computer running RecordBase Central Station:

Network [7]

Identification | Servicss | Pretocols | Adapters | Bindings |

E ‘Windows uses the following information to identify your
—| computer on the netwark, Yiou may change the name for

ﬂpen . th.; comptr ane the workgroup or domain that it vl
) E leDrE —— Computer Name: [Computer 99
! :_. 2 = Damair APT
LA Find Compute: !

i Change

tdap Mebwaoflk
Lhizconnect|M

Create Shoiftc
RHename

0K Cancel !

Step 1 - Right-click Step 2 - Select the Identification tab.
Network Neighborhood L—] The Server identifcation is the text
to select Properties. in the Computer Name field.

Figure 4.2: Identify Server Computer

1 Onthe computer running RecordBase Central Station, in Windows Explor-
er, right-click Network Neighborhood to select Properties from the drop-
down menu.

2 Select theldentificationtab. The Server ID isthetext in the Computer Name
field.

Server Info Tab
!Heculdﬂase Zollector =3
IED Info ServerInfo | Logrfa |

Server |0:] Computer 99 =
FecordBase Shutdow

Appl | [Eance] I e I

[Connected i

1
|Server Status| |Network Name of the Server Computer |

Figure 4.3: Collector Module - Server Info tab
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Collector Collection
Status

The Collector shows the status of its communication link with the server inits
Status Bar at the bottom of its window.

If the communication with the server isworking, the status says “ Connected.”
If it says “Not Connected,”

1

Check that the correct Server 1D name (or |P address) has been entered in
the Server Info tab, for details seefor details see Figure 4.3: Collector Mod-
ule - Server Info tab on page 4-2.

Check that the server computer is accessible on the network by using Win-
dows Network Neighborhood and/or Explorer.

Check that the computer you are working on and the Server have established
aTCP/IP connection by running ping Server 1D. Y ou can do thisinthe Run
service available through the Windows Start menu. The TCP/IPlink is
working if the server responds to the ping.

Check that the server is running the RecordBase application by bringing up
Task Manager on the server (Ctrl, Alt and Del keys simultaneously) and
checking for SystemManager.exe in the Processes view.

Adding a Recorder to the List

Use RecordBase Collector to add each TESLA recorder to RecordBase’ s list.
1 Therecorder list is shown under the Collector’s |[ED Info tab.
2 To add anew recorder to thelist, use the New... button.

EﬂeculdBase Collector _ (O] ]

Connected

IED Infa 1 Serverlnfn] Lnglnm]

Uit D Location
Demo #1
Boswell 4
Dorzey #1
Dorsey #2

[

| | Cloze |

Figure 4.4: Collector Module Record List
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TESLA 3000
Cooperative Mode

x4
UnitlD:  [okrown
IED Serial #: ]—
IED Type: ]ﬁ
Location: W

~ Communication
" Modem

Phone Nurnber:

 LAN

IF Address: i I

1 Do Mot Connect

Cancel

Figure 4.5: Setup New IED

3 Enter the phone number or | P address and the location of the TESLA you
are adding.
Note that the UnitID and IED Serial # fields are read-only. They are auto-
matically filled in with information gathered from the recorder when a
connection is established. You can manually collect thisinformation
using the Get Information from IED button, after pressing the Edit button
on RecordBase Collector’s main screen.

4 Select the OK button.

Before RecordBase will accept a call from an IED, the IED Serial #
must be known.

When adding a TESL A 3000 recorder that is part of a Cooperative group, it is
important to add only one of the group membersto thelist. Typicaly, thiswill
be the one recorder that is the ' gateway’ to the Cooperative group. When Re-
cordBase contacts this recorder it will automatically detect that it is part of a
Cooperative group and will fetch/combine record fragments appropriately

Notethat if multiple TESLA 3000 recorders from the same Cooperative group
are mistakenly added to the list and RecordBase performs cross-triggering,
those recorders will be cross-triggered multiple times for the same event, re-
sulting in undesirable behavior.

If RecordBase is to contact a TESLA 3000 recorder that is part of a
Cooperative group via dial-out (modem), the Windows User Account
that it is running under must have Administrative privileges. This is
because RecordBase must temporarily modify the Windows routing
table during the connection.
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4 Record Collection

Polled Record Collection

Enable Collection

Collection Time

Call Order

Limiting Late Calls

RecordBase can be set to poll its recorders on a scheduled basis and automati-
cally transfer new records to the central database.

To configurerecord collection for arecorder, select the unit in the RecordBase
Collector’s IED Info tab, then select the Collection Rules button.

IED Collection Rules
¥ Enable Palling

[T Sunday [ Monday [ Tuesday I wWednesday

I Thusday [ Friday [~ Saturday

Start Call &fter | 0:00 =
" End Call Before [ 50 =
* Mo Limit

Session Limits

Mawimurn Records Transferred {100 [1-333)
Tirne Lirit 123 [1-23 haurs]

Rty Attempts
b awimum Sttempts 15 [1-39]
Delay Between Attempts 12 [1-3 mituites]

Record Handling
' Transter Mewest Fecords First
" Transfer Oldest Records First

[ Delete &fter Transfer and Verification

i~ Ihcoming Callz
v {Enable Cross-Triggering of Other [EDs
™ Start Collection Immediately After Crozs-Trggering

ak, | Cancel J

Figure 4.6: Collection Rules

To enable scheduled polling for new recordsfor thisrecorder, select the Enable
Collection box.

Each recorder can be called at a specified time, on any day of the week to poll
and retrieve new records.

Only records that are not already contained in the RecordBase database are
transferred.

Y ou can control the order in which recorders are called through the Sart Call
After field. Thefirst recorder to be called isthe one with the earliest Start Call
After time. When that first call iscomplete, acall isplaced to the recorder with
the next earliest Start Call After time evenif it ispresently later than that time
due to along call with the first recorder. If an attempt to communicate with a
recorder fails, RecordBase will reschedule the call and go on to the next in the
queue.

A call window can be defined with the End Call Before parameter which limits
how late acall can take place. If No Limit is selected, the call can take place
any time after the Sart Call After time.
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4 Record Collection

Limiting Record
Transfers

Call Scheduling

Record Transfer
Order

Erasing Records
from the Recorder
after Transfer

Y ou can limit the call session by the Maximum Records Transferred settings.
This limits the number of records that can be transferred during the call and
Time Limit of each call.

If acall to arecorder is unsuccessful (for example, due to abusy signal), the
call will berescheduled. If acall to another recorder can be made, RecordBase
will automatically switch to that call. If not, RecordBase will try the same re-
corder again. The Delay Between Attempts setting can be used to ensure amin-
imum interval between call attempts to the same recorder. The Maximum
Attempts setting limits the number of timesacall isretried.

The Transfer Newest/Oldest Records First selection lets you determine how
RecordBase should sequence record transfer when there are multiple records
available. Thisisimportant if you have placed limits on the number of records
that can be transferred in a session or on the duration of acall.

Y ou havethe option of automatically erasing recordsfrom arecorder after they
have been transferred and verified to be whole and error-free. Deletion of the
record on the recorder takes place only after the integrity of the transferred
record has been verified using an error detecting CRC embedded in TESLA
records. If an error is detected in the transferred file the problem is reported in
the Diagnostic log, for details see “ Diagnostic Log” on page 5-4.

RecordBase determines which records to transfer from a recorder by compar-
ing the record list on the recorder with the contents of the RecordBase data
base. If you choose not to del ete records on the recorder, RecordBase will till
only transfer the new records.

Selecting the Delete After Transfer and Verification option is recom-
mended. It speeds up the check for new records and makes it easier
to manage the recorders.

If this option is selected and RecordBase Central Station is connect-
ed to a TESLA that is part of a Cooperative group, the corresponding
record fragments (partial records) will be deleted from each recorder
after a successful transfer.
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Manually-Initiated Record Collection

Y ou can manually initiate a record collection call to one or more recordersin
addition or as an alternative to scheduled poll calls. Use the RecordBase Mon-
itor utility to do this. Inthe IED Statustab select one or more recorders and the
Collect Now button to initiate the calls, for details see “ RecordBase Collector
Module” on page 4-1.

i RecordBase Monitor [_[Olx]|

IED Status ]Activity Log] Diagnostics Log]

| Last Call | Call Status

| Uritio | Location

el T
Wed May 09, 2001 17:16:04 cross gger re-scheduled
‘wied Map 09, 2000 11:16:22 cross rigger re-scheduled
Wed May 09, 2000 11:16:42 CIoss rigger re-scheduled

Ridgeway Winnipeqg Sauth

Cross Trigger Callect Mow

Pririt Clase

[Connected

Figure 4.7: RecordBase Monitor

The call order for manually-initiated calls follows the order in which the re-
corders appear in thelist.

The collection rules in place for each recorder are followed, for details see
“Polled Record Collection” on page 4-5, except that the start and end times do

not apply.

Recorder-Initiated Record Collection

Record transfer can also be initiated by the recorder. TESLA recorders can be
configured to call RecordBase when new records are created.

A recorder must bein RecordBase’ slist (for details see “ Adding a Recorder to
the List” on page 4-3), for an incoming call from it to be accepted. If acal is
received from arecorder that is not in thelist, the call is declined and the error
islogged in the Diagnostic Log.

RecordBase must have a separate dial-in modem or LAN connection
to receive incoming calls from a recorder.

RecordBase respondsto incoming calls by checking for cross-trigger eventsin
the recorder’ slog and checking for new records. If new records are available,
RecordBase hangs up and calls back on its dial-out modem or LAN to handle
the record transfer ensuring that the dial-in modem is available to receive in-
coming calls. If the dial-out modem is busy, the call is queued. RecordBase
transfers all new records from the recorder, except where limited by settings.
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4 Record Collection

It uses the same settingsto limit the session, manage retry attempts and control
the transfer process as a RecordBase initiated poll call, for details see * Polled
Record Collection” on page 4-5.

When setting up recorder-initiated record collection on a Cooperative group, it
isimportant that only the 'gateway' member be set to notify RecordBase. The
other members of the Cooperative group should not notify; when RecordBase
receives notification from the 'gateway' member, it will automatically fetch re-
cordings from all of the Cooperative group's members.

Central Cross-Triggering

Cross Trigger
Process

Trigger Rejection
Window

Cross-Trigger
Settings

RecordBase can be set to trigger dynamic swing records (viamodem or LAN
onall itsrecordersin response to an appropriate trigger from onerecorder. The
result isaset of recordsthat gives a synchronized system-wide snapshot of the
disturbance. Any of arecorder’s detectors can be set to initiate a notification
call to RecordBase when triggered.

A recorder must be in RecordBase’ slist to accept an incoming call, for details
see“Adding aRecorder tothe List” on page 4-3. A call received from arecord-
er not on thelist is declined and the error is logged in the Diagnostic Log.

RecordBase must have a LAN connection or a separate dial-in mo-
dem to receive incoming calls from a recorder, for details see “Mo-
dems and Telephone Lines” on page 2-2 and “Network Connection”
on page 2-2.

When the incoming call is received, RecordBase checks the recorder’ s event
log. If anew central cross-trigger event isfound, RecordBase initiates record-
ing on the other recorders by calling them and issuing swing trigger com-
mands.

The swing trigger command includes the time stamp of the initiating event.
Each recorder goes back in its 20 minute swing data running buffer and cap-
tures arecord for the same time frame using the time stamp asitstrigger time
and including pre-trigger and post-trigger data according to the recorder’ s con-
figured recording parameters.

If the swing trigger command cannot be delivered to arecorder while the data
is still present in the 20 minute buffer, that unit will not be able to provide a
recording.

To avoid needless loading of the communication channels, RecordBase ig-
nores triggers whose time stamp is within 10 seconds of any previous trigger.
Ignored triggers are reported in the Diagnostic Log.

Settings to control the RecordBase swing cross-trigger handling are available
as part of the collection rules, for details see for details see Figure 4.6: Collec-
tion Rules on page 4-5.

TheEnable Cross-Triggering of Other |EDs selector allows or preventstrigger
reports of arecorder from initiating records on other units.
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TESLA 3000
Cooperative Mode

The Retrieve Cross-Triggered Records Immediately setting tells RecordBase
to call each recorder to pick up the records. If thisis not enabled, the record
won’'t be picked up until the next scheduled poll or until arecorder-initiated
record transfer call isreceived.

When RecordBase cross-triggers a TESLA 3000 that is part of a Cooperative
group, al recorders participating in that group will be automatically triggered.

It isimportant that only the 'gateway' TESLA be set to notify (cross-trigger)
RecordBase. The other members of the Cooperative group should not be set to
do this.

Manual Cross-Triggering

Y ou can manually initiate time-coordinating cross-triggering of dynamic
swing records on al the recorders.

Usethe Cross-Trigger button under the |ED Status of the RecordBase Monitor
utility to do this, for details see “ RecordBase Monitor Module” on page 5-1.

The Cross-Trigger button initiates a call to each recorder and issues a com-
mand to captures a dynamic swing record.

Thetrigger time for al the records is the time at which the Cross-Trigger but-
ton was selected. All recorders are called, regardless of any selectionsmadein
the record list.

Note that manual cross-triggers generate swing recordings having a
status of 'IRIG-B unsynchronized', regardless of the state of the unit's
IRIG-B input.
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5 Communication Monitoring

RecordBase providesinformation on the current communication status of each
recorder and alog of communications activity and problems through the Re-
cordBase Monitor module.

RecordBase Monitor Module
RecordBase Monitor isautility program that providesinformation on the com-
muni cation between RecordBase and the TESLA recorders. It provides:
» Timeand result of last call made with each recorder
« Communication Activity Log
* Diagnostic Log
* Manual cross-triggering of recorders
» Manual collection of records from recorders

RecordBase Monitor can be run on the Server or on another computer on the
network that has a TCP/IP connection with the server.

Monitor showsthe status of its communication link with the server inits Status
Bar at the bottom of its window. The Status Bar should say “ Connected.” If it
says “Not Connected,” for details see “RecordBase Monitor Module” on
page 5-1.

Before you can run RecordBase Monitor on a computer for the first
time, you must first identify the network name of the RecordBase
Central Station by using the RecordBase Collector to set the Server
ID field.

§i4 RecordBase Collector [_ |0

|ED! Info ] Server Inf01 Laog InFD]

| UnitlD | Laeation _ Hew..
Dorzey #1 Darzey Station -
Boswell 4 Bozwell Station
Ridgeway Winnipeg South

Apply | Cancel ‘ Cloze

{Connected

Figure 5.1: RecordBase Collector
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5 Communication Monitoring

|[ED Status

|IED Status Tab| [Location | Last Call | Call Type | [Call Status|

#{ RecordBase Monitor

IED Status | activiy Log | Diagnosfes Log |

Location Last Call Call Typpe Call Status |

2
top FriJun 09, cross Hgger
battorn FriJun 09, 2000 10:40:05 manual pickup

UnitlDr

TESLA Test Unit #1
TESLA Test Unit #2

connecting

Crozs Trigger Callect Mow |
Fririt Close

|Connected

Figure 5.2: IED Status

7

The status of the last call made with each recorder is shown under the IED Sa-
tustab of RecordBase Monitor. The Last Call column indicates the reason for
the most recent call with the recorder. The Call Result column shows dynamic
statusinformation during acall. When the call isover, it indicates the outcome
of the call. See table following.

Call Type

Call Status

Application

Scheduled Pick-up

Connecting, fetching ID, fetching list,
re-scheduled, failed, successful,
fetching records

A scheduled record pick-
up

New Record Pick-up

Connecting, fetching ID, fetching list,
re-scheduled, failed, successful,
fetching records

A record pick-up in
response to “New
Records” notification from
an IED

Xtrig Record Pick-up

Connecting, fetching ID, fetching list,
re-scheduled, failed, successful,
fetching records

A record pick-up after a
cross trigger

Manual Pick-up

Connecting, fetching ID, fetching list,
re-scheduled, failed, successful
fetching records

A manual record pick-up
(user pressed the “Collect
Now” button)

trigger, new records

Cross Trigger Connecting, fetching ID, re- A call to cross trigger an
scheduled, failed, triggering, IED
triggered

Incoming Fetching ID, failed, successful, cross- | An incoming call from an

IED

Synchronization

Connecting, fetching ID, re-
scheduled, failed, successful

A call to fetch an IED’s
identification
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5 Communication Monitoring

Activity Log

#fjRecordBase Monitor (O[]
IED Statys Activity Log 1 Diagnostics Log]
Time: Uit 10 Message i‘
FriJun 09, 2000 10:40:55 Fred (<] collection started
FriJun 09, 2000 10:40:51 Bamey (<) collection successful
FriJun 09, 2000 10:40:05 Bamey (<) collection started
FriJun 09, 2000 10:35:45 Bamey [+] record collection requested
FriJun 09, 2000 10:38:32 Bamey manual collection in 180 seconds
FriJun 09, 2000 10:38:32 Barmey [¢] cross trigger successhul [FriJun 0912:37:32)
FriJun 08, 2000 10:36:05 Bamey [<] cross trigger started (FriJun 03 12:37.32)
FriJun 09, 2000 10:36:02 Fred manual collection in 180 seconds
FriJun 09, 2000 10:38:02 Fred (<] cross tigoer successtul [FriJun 03 12:37:32)
FriJun 09, 2000 10:37:35 Fred (<) cross trigaer started (FriJun 09 12:37.32)
Fri.Jun 09, 2000 10:37:32 manual cross tigger accepted (Fridun 09 12:37:32)
FriJun 09, 2000 10:36:42 Fred (<] collection successful j

Print Close

Connected

Figure 5.3: Activity Log

A communication activity log provides a history of the calls made to and from
each recorder. Thelog is available under the Activity Log tab of the Record-
Base Monitor utility. The log specifies the date and time of the call, the name
of therecorder, the call direction (incoming or outgoing) and the call type. The
log display can show communication with all recorders.

The activity log is circular, the oldest entries are automatically over written
when its maximum size is reached. The size of the RecordBase logsiis set
through the Log Info tab of the RecordBase Collector module.

Changing the Activity Log size clears all log entries.
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Diagnostic Log

Ak RecordBase Monitor

IED Status} Activity Log  Diagnostics Log }

[_[O]x]

Tirne

FriJun 09, 2000 10:42:33
Fridun 09, 2000 10:40:55
Fridun 03, 2000 10:40:51
Fridun 09, 2000 10:40:28
FriJum 09, 2000 10:40:05
Fridun 09, 2000 70:38:32
FiiJun 09, 2000 10:3805
FriJun 09, 2000 10:38:02
Fridun 09, 2000 10:37:35
Fridun 03, 2000 10:36:42
Fridun 09, 2000 10:36:18
FriJun 09, 2000 10:35:55

Unit 1D
Fred
Fred
Bamey
Bamey
Barney
Bamey
Bamey
Fred
Fred
Fred
Fred
Fred

Message

(<] &rass tigger started [Fri Jun 09 12:42:32)

[<] collection started

[<] collection successful

fetching 3341 2B5C0008 1 of 1]

(<] collection started

[<] cross tigger successful (Fridun 0912:37.32]
<] eross rigger started [Fri Jun 03 12:37:32)

(<] &rass tigger successhul (Friun 09 12:37:32)
(<] cross trigger started [Fri Jun 09 12:37:32)

[<] collection successful

fetching 394124300008 (1 of 1)

(<] collection started

Frirt

Connected

Figure 5.4: Diagnostic Log

Communication difficulties between RecordBase and the recorders arelogged.
Thelog is available under the Diagnostic Log tab of the RecordBase Monitor
utility. Thelog provides details of communication difficulties, such asrepeated
busy signals, loss of connection and data errors. The log display can be set to
show messages about communication with all recorders or be filtered to mes-

sages pertaining to asingle recorder.

The activity log is circular, the oldest entries are automatically over written

the Log Info tab of the RecordBase Collector module.

when its maximum sizeisreached. The size of RecordBase logsis set through

Changing the Diagnostic Log size clears all log entries.
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6 RecordBase Administrator

The RecordBase Administrator moduleis atool that lets you manage the Re-

cordBase Central Station database. RecordBase Administrator isidentical to
RecordBase View, except for the addition of:

RecordBase Administrator RecordBase View

Records->Delete option is available Records->Delete option is available (with an
exception to delete record(s) from the server
database)

Options->Record Classification option is Options->Record Classification option is not

available available

File->Open option is not available File->Open option is available

Records->Transfer records option is not Records->Transfer records option is avail-

available able

Refer to RecordBase View User Manual for further instructions.

Record Classification System

RecordBase Administrator lets you define arecord classification system for la-
belling records. Each record can be manually assigned a classification when it
has been analyzed. The classis assigned using the Classification pick list. Up
to 10 classes can be defined. Enter the text for each class in the Name column.

Choose Options>Record Classification
fromto bring up the Record Classification
window.

{{iRecordBase Admin - | RecordBase Admin]
|| Bl Edt Records | dptions Help
”MGraph ‘ [ viewse | AddRecord Ijnrts - ‘ [Badd [ Delede Export (liSend [G Saveta ‘ % [ ) |
Trigger Tims (b Record flame | 2001-03-14-09.50.08 53361 KCEL A |
2 Triggjer|Time [2001-05-14 08 50:08 533
StarifTime 2001-03-14 09.49:45 533

Stop{Time 2001-03-14 03:50:48 533 |
it ID unspecifisd

g

2 Mot et Analyzedl
3 Mormal Operation
4 Marginal Operation
& Incorrect Operation
5 Requires Further Investigation

Records Found: 11

& nthe past 25| vee
" Between | 2001-Jan 01

[Form iew

Record: 1] 4 || T ok |r]re]of e

Figure 6.1: Record Classification Window
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6 RecordBase Administrator

1 Open the Record Classification window by selecting the menu Options>
Record Classification.

2 Closethe Record Classification window when done. Changes are automat-
icaly saved.

Deleting Records

To delete arecord, select the record from the record list using the mouse and
select the Delete button in the main Windows toolbar, or pressing the Delete
key. Y ou are prompted for confirmation before deleting. Multiple records can
be selected by using the mouse while holding down the shift key (for a contin-
uous block of records) or the Ctrl key (for a non-continuous block of records).
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Software Installation Instructions

To Install Software
on your Computer

The CD-ROM contains software and the User Manual for RecordBase Central
Station.

Software isinstalled directly from the CD-ROM to a Windows PC.
The CD-ROM contains the following:

» RecordBase Central Station interface software
» RecordBase Centra Station User Manual in PDF format

Before attempting to install the software, you must ensure you arelogged into
an account with Administrator privileges.

Insert the CD-ROM in your drive; the CD-ROM should open automatically. If
theit does not, go to Windows Explorer and find the CD-ROM (usually on D
drive). Open the CD.exe file to launch the CD-ROM.

Toinstall the software on your computer, click the desired item on the screen.
The installation program launches automatically. Installation may take afew
minutes to start.

To view the User Manual you must have Adobe Acrobat on your compuiter. If
you need a copy, download a copy by clicking on Download Adobe Acrobat.
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